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Figure 1: SCUP, WSUS and WUA Architecture for Cus-
tom Updates
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SECTION 1
EXECUTIVE SUMMARY

This technical white paper describes the Dell Catalog to support Mi-

crosoft System Center Configuration Manager (SCCM) 2007 for Dell

system updates. It provides an overview of the system update proc-

ess using Dell Catalog, Microsoft System Center Update Publisher

(SCUP) and SCCM. This white paper describes the steps that

should be followed to:

1. Import the Dell Catalog into Windows Server Update Services
(WSUS) using SCUP tool

2. Import updates from WSUS into SCCM

3. Scan managed systems using SCCM

4. Deploy the necessary updates to the Dell systems using SCCM

Finally, this white paper also provides some tips and best practices
when using SCUP and SCCM to import Dell catalog and update Dell
system BIOS, firmware, driver and Dell applications.

SECTION 2
INTRODUCTION

Managing hardware updates for BIOS, firmware, driver and hard-
ware related applications has become a key activity for an IT admin-
istrator. In enterprise environments, it can be very complex and time
consuming as the IT administrator needs to determine compliance,
plan the update, select the appropriate hardware updates and be
able to deploy the updates to the right set of systems for keeping the
environment stable and reliable.

Dell Catalog along with Microsoft System Center products SCUP,
WSUS and SCCM provides the solution that will assist IT administra-
tor in updating Dell systems with the latest Dell BIOS, firmware, driv-
ers and Dell applications available. As IT administrators design and
implement a holistic methodology to manage their software and se-
curity patch updates, by importing Dell content into SCCM, IT admin-
istrators can also plan for updates using the same process. This
minimizes the resources required to transport Dell hardware updates
across the network and simplifies the IT process.
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SECTION 3

The Overview of Dell Catalog, MSFT SCUP, and WSUS

System Center Updates Publisher (SCUP) is an add-on application

designed to extend the software update management functionality in

System Center Configuration Manager 2007 (SCCM). It provides ad-

ministrators the ability to import, create, and publish custom software

update information to their SCCM server. By using the Updates Pub-

lisher to define a custom software update and publish it to the server,

administrators can begin detecting and deploying that update to the

managed systems in their organization. The System Center Updates

Publisher enables administrators to do the following:

e Create the correct applicability and deployment metadata for an
update that can be managed through SCCM

o Import catalogs of updates from third-parties (such as Dell) and
from within the customer’s own organization

e Export and share these software updates catalogs

e Manage custom software update information

Microsoft has designed WSUS to be a platform for updates for virtu-

ally any size business. That platform includes the underlying frame-

work and an administration console that is free to use. SCCM build

on top of the WSUS infrastructure and provide the tool to manage

the enterprise environments.

As you can see from the Figure 1, SCUP is a component of a com-
plete infrastructure involving Windows Update Agent (WUA), WSUS,
management products such as System Center Essentials (SCE) and
SCCM, custom updates catalogs such as Dell catalog and binaries
from third-party sources such as Dell Update Packages.
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Figure 1: SCUP, WSUS and WUA Architecture for Custom Updates
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SECTION 4
How to Use SCUP to Import Dell Catalog

This section will provide step by step instructions on how to use the
SCUP tool to import Dell Catalog, set the correct configuration for
SCUP, publish and verify the updates from Dell catalog.

It will assume that the IT administrator has already downloaded and
installed the SCUP tool on a system.

After the IT administrator installs and launches the SCUP tool on a
system, follow the steps below:

1. Click Action > Settings to launch SCUP Settings menu.

Settings

Impart List | Update Server | Data Source | Trusted Publishers | Advanced

-

Configure the list of catalog files you want bo import regularl.

[] Automatically check for updates bo my catalogs on startup

Irnport Lizt:
Publizher Mame | Path | Source Obsolete

sdd | End | Edi Femove

[ ok, ]’ Cancel ]
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Settings i

2. From the Settings menu change tabs to Update Server and check

“‘Enable publishing to an update server”. Configure the settings

based on the environment and test connection.

Import List Update Server I Data Source | Trusted Publishers | Advanced |

v {Enable publishing to an update server.:

21|

— Settings

Enter the update server that will be used for publishing. Administrative rights are
required on the update server to successfully publish updates.

(¢ Connect to a local update server.
" Connhect to a remote update server:

r [ze Secure Sockets Layer (S5L] when commuricating with the
updates server

Name: | Port: I

Test Connection |0

— Signing Certificate

The signing certificate is used to digitally sign content you want to publish ta the
update server. Browse to a signing certificate that you want to use and choose
Create. You can leave the File entry box blank and choose Create to have the
update server auto-generate a self-sianed certificate.

Browse, . Lreate Bemove

Last recorded update server certificate
Certificate issuer:

Expiration date;

oK Cancel Apply
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3. Next create or import a Signing Certificate that will be used to
setup the trust relationship between SCUP, SCCM, and the man-

aged clients. Once complete click Apply. See “Tips and Best

Practices using SCUP and SCCM (Q&A)’ for additional infor-

mation on how to export/import the WSUS Publishers Self-signed
Certificate.

settings 2| x|

Import List Update Server I Data Source | Trusted Publishers | Advanced |

[V Enable publishing to an update server.

— Settings
Enter the update server that will be used for publishing. Administrative rights are
required on the update server to successfully publish updates.

(¢ Connect to a local update server.
" Connect to a remote update server:

[Use Secure Sockets Layer (S5 when commuricating with the

Name: | Port: I

Test Connection l

— Signing Certificate
The signing certificate is used to digitally sign content you want to publish to the
update server. Browse to a signing certificate that you want to use and choose

Create. You can leave the File entry box blank and choose Create to have the
update server auto-generate a self-signed certificate.

Eile: [

Browse... I

Last recorded update server certificate

Certificate issuer: CN=WSUS Publishers Self-signed
Expiration date: 5/6/2018 3:44:04 PM
oK Cancel Apply
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4. Now switch tabs to Import List and click Add or Find depending
on SCUPs internet access availability;
a. Clicking Find will launch the Discover and Add External Cata-
logs menu; this will automatically retrieve a list of available Cata-
logs from Microsoft’s site. From the External Catalogs menu select
publisher “Dell” and click Add > then OK.

Discover and Add External Catalogs
Choose catalogs from the External Catalogs list to add to the Import List.
Extermglrc‘alalog[s]: - N PI'_losgq qatalog[s] o
| Publisher Name [ Publisher Name
| 1E 1E Updates Catalog ‘ / | Dell [SCCM and SCE ONLY] Dell Server Updates (
Citrix Systems Inc. Citrix Hotfix Catalog
Intel Intel S M B
nte ntel Server Managemen add Al
Remove all
, | &l e
Catalog Details:
URL: ftp:#/ftp.dell. com/catalog/DellSDPCatalog.cab
Support:
Description:

This catalog supports server updates for Dell PowerEdge and PowerYault server products. IMPORTANT: This catalog applies to Configuration
Manager 2007 and System Center Essentials 2007 only. This catalog will not work correctly on SMS 2003 systems.

[ 0K ][ LCancel ]
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b. Clicking Add will launch the Edit Catalog menu; enter ftp://
ftp.Dell.com/Catalog/DellSDPCatalog.cab in the Choose Path field
and Dell Inc. in the Publisher field. All other information can be
entered as desired; then click OK.

foettings 21|
Import List I Update Server | Data Source | Trusted Publishers | Advanced |

Choose a local path, UNC file share, or URL from which to automatically import a catalog.

Choose Path:

|ftp:.f'e’ftp.DeII.com/Catalogf'DeIISDPCatalog.cab Browse... I

For Example : \smyserversmysharehmyfile.cab or http: //mycatalogweb/mycatalog.cab

Publisher: |Del| Inc.
Name: [Dell SDP Catalog
Description: Dell SDP Catalog for SCCM or SCE 2007
Support: |http: //support. dell.com/
Import Settings:

IV Require approval of unsigned catalogs from this location during import

[~ Always flag these updates for publishing

0K LCancel

0K Cancel Epply
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5. The Dell Catalog will now appear under the Import List; to receive
automated updates on the Catalog check the “Automatically
check for updates to my catalogs on startup” box.

Note: IT administrators are still required to launch the SCUP in
order for automatic catalog update check to occur. The check will

notify the administrator of updated Dell Catalog’s available for
download.

Settings 21

Import List l Update Server | Data Source | Trusted Publishers | Advanced |

Configure the list of catalog files you want to import regularly.

IV Automatically check for updates ta my catalogs on startup

Import List:

Publi... l Name l Path I Source l Obso
Dellinc. Dell SDP Catalog  ftp://ftp.Dell.com/Cata...  Intemal Na

Add Catalog x|

1 ) Successfully added catalog to the database.

< | B

Add B edit | Bemove | Removeay |

0K l Cancel | Apply l
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6. On the Operating System that is hosting the WSUS database click
the Windows Start button and select the Run option. Type MMC
and click OK. Next click the File > Add/Remove Snap-in. Click
the Add button and select Certificates > Add > Computer Ac-
count > Next > Local Computer > Finish. Press Close on the
Add/Remove Snap-in pop-up menu. Press OK on the Add/
Remove Snap-in menu.

Add/Remove Snap-in i 21|

Standalone IExtensions |

Use this page to add or remove a stand-alone snap-in from the console.

Snap-ins added to: l‘_j Console Root EI i

@Certiﬁcates {Local Computer)

— Description

Hemave Abouts,, |

oK | Cancel
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7. Expand the Certificates tree and select the WSUS > Certificates

folder, select the WSUS Publishers Self-signed certificate right
click and choose Copy.

"Hi Console2 - [Console Root'Certificates {Local Computer)}WSUS' Cettificates]

“& File Action View Favorites Window Help

e | OE 4B XER 2B
(L1 Console Root Isst
- Certificates (Local Computer) 2
-1 Personal
[Z1 Trusted Root Certification Authorities Al Tasks >
(Z2) Enterprise Trust L e
-] Intermediate Certification Authorities
-1 Trusted Publishers
-1 Untrusted Certificates Delete
(21 Third-Party Root Certification Authorities _—
(Z2 Trusted People
(Z1) Other People Help
-1 sM3
([ spC
=3 wsus
= Certificates

Open

Cut

Properties

«| | i

|Copies the current selection. [
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8. From the Certificates tree select Trusted Root Certification Au-
thorities > Certificates and click Action > Paste. Close the MMC
Console.

'}'m Console2 - [Console Root'Certificates {Local Computer) Trusted Root Certification Authorities\Cert = |D|5|
“&i] File Action View Favorites ‘Window Help ' 18] x|
&= | AmE B XER 28
(L] Console Root Issued To  / | Issued By I Expiration Date I Intende «
=1 Certificates (Local Computer) = Thawte Personal Premium CA Thawte Personal Premium CA 1231/2020 Client &
(3 personal El Thawte Premium Server CA Thawte Premium Server CA 12312020 Server
& D Trusted B_°°t Certification Authorities Thawte Server CA Thawte Server CA 12312020 Server
D"Eﬂt ce't'f":test Thawte Timestamping CA Thawte Timestamping CA 12/31/2020 Time St
308 Enterprise Trus U - DATACE -
3 L " p SGC UTN - DATACorp SGC 6/24/2019 Server
B 8 IT“te't'";‘:_:a;T f’t'f'cat"’" Audrides [E=JUTH-USERFirst-Client Authenticati... UTN-USERFirst-Client Authentication...  7/9/2019 Secure
T isher:
i~ il EUTN-USERFirst-Hardware UTN-LISERFirst-Hardware 7/9/2019 Server
-3 Third-Party Root Certification Authorities [EUTN-USERFirst-Network Applications UTN-USERFirst-Netwark Applications 71912019 Secure
& C] Trusted People UTN-USERFirst-Object UTN-USERFirst-Object 71912019 Time St
#-(2] Other People [Everisign Commercial Software Pub... VeriSign Commercial Software Publis...  12/31/1999 Secure
&3 sMs [Everisign Commercial Software Pub... VeriSign Commercial Software Publis...  1/7/2004 Secure
&3] SPC VeriSign Individual Software Publis... YeriSign Individual Software Publishe... 12/31/1999 Secure
=3 wsus [Everisign Individual Software Publis... VeriSign Individual Software Publishe...  1/7/2004 Secure
C] Certificates VeriSign Time Stamping Services CA  Thawte Timestamping CA 12§3f2013 Time St
VeriSign Time Stamping Services Si... YeriSign Time Stamping Services CA 1243f2008 Time St
[Everisign Trust Network VeriSign Trust Network 5/18/2018 Secure
VeriSign Trust Network VeriSign Trust Network 8/1/2028 Secure
eriSign Trust Networl eriSign Trust Networl ecure
Everisign Trust Metwork VeriSign Trust Network 5/18/2018 S
Elverisign Trust Network eriSign Trust Network 8/1j2028 Secure
VeriSign Trust Network eriSign Trust Network 5/18/2018 Secure
eriSign Trust Networl eriSign Trust Networl ecure
[Elverisign Trust Network VeriSign Trust Network 8/1j2028 S
‘v'eriSign Trust Network VeriSign Trust Network 8/1j2028 Secure
Everisign Trust Metwork VeriSign Trust Network 5/18/2018 Secure
ub F ub F
[Excert E2 by DST Xcert EZ by DST 711142009
<] |
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9. Back at the SCUP front page click Action > Import Updates; this
will launch the Import Software Updates Catalog Wizard. Select
Bulk Catalog Import then Next.

Import Software Updates Catalog Wizard x|
gj Select Import Method
Summary Select Import Method
Progress & F
Confirmation This option allows the automatic import of files that have already been
configured using the Import Files configuration screen,
" Single Catalog Import
This option allows the manual import of a specific catalog file.
< Previous | Mext = I Einish I Cancel I
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10. A summary will be displayed of importing the Dell Catalog. Also
for the first time a Security Warning will prompt to accept the Dell
Catalog. Choose “Always accept catalog from Dell Inc. “ for no
further prompts to occur.

Import Software Updates Catalog Wizard _ .

g_\g Progress

Select Import Method Status: Importing from DellSDPCatalog.cab
Summary
Brogress) Catalog Yalidation - Security Warning ] 5] ——
Confirmation
Do you want to accept this catalog?
Name : DellSDPCatalog.cab
Publisher:  Dell Inc
(&) &lways accept catalog from ' DellInc
(O Ask me every time
Accept Don't Bceept
S Catalog files from untrusted publishers can potentially harm client computers when
scanning for updates. Only accept catalogs from publishers you trust.
Tell Me More
< Previous ext = Einish I Cancel I
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11. Click Close after import is complete and SCUP will return back to

the SCUP front page. Under the Console Tree the Dell group will
now be present with three sub-categories; Bios, Drivers and Appli-
cations, and Firmware. Browse the categories to select individual
updates to publish or click the top level Dell group and select Set
All Publish Flags from the Action Tree menu to publish all up-
dates.

Note: At a minimum publish the Dell OpenManage Inventory
Agent located in the Dell Drivers and Applications section. This
agent is the inventory collection tool that must first be installed on
SCCM Dell managed clients to collect inventory and populate to
Windows Management Instrumentation (WMI) so that all other up-
dates can be evaluated.

"fn System Center Updates Publisher _i8(x|

Fie Action View Help

« - & 2@

4z System Center Updates Publisher Actions
-3 Del Drivers and Applications a

% Bios age Inventory Agent Important Updates 4 English

2% Drivers and Applications Dell OpenManage Server Administiator Managed Node, v.5...  Moderate Updates  4/9/2008 English False (4] create Update

% Firmware Dell 545 5/iR and 6/ Adapter, SAS 5/ and 6/ Integrat... Important  Updates  4/3/2008 Engish  § Fake 1 Import Updatels)
Dell SAS 5/i Integrated, v.1.24.04.40, ADG Impotant  Updates  3/18/2008 Engish False =
Dell SAS 5/iIntegrated, v.1.24.04.40, ADG Important Updates  3/18/2008 Engish W True [l Publish Update(s)
Dell SA5 5/i Integrated, SAS 5/E Adapter, v.1.24.04.40,406  Crical Updates  3/18/2008 Engish & True & settings
Dell S45 5/R and 6/ Adapter, SAS 5/R and 6/ Integrat... Important  Updates  3/18/2008 Engish & True
Dell SAS 5/R Integrated, SAS 5/iR Adapter, v.1.24.04.40, A...  Important Updates  3/18/2008 Engish & True i Manage Rules
Broadcom NetXtieme Il Base Driver Dell Update Package, v... Important  Updates  3/18/2008 Engish  © Fakse L Export
Broadcom Nebtreme Base Driver Dell Update Package, v.1... Impottant  Updates  3/18/2008 Engish ¥ False =
Broadcom NeiXtreme Family of Adapters, NetXireme Il Famil... Impottant ~ Updates  3/18/2008 Engish & False ¥ setpuich Foc:
Dell SAS 5/ Integrated, SAS 5/E Adapter, v.1.24.04.40, 408 Crical Updates  3/18/2008 Engish False & Clear All Publish Flags
Broadcom NetXieme Farily of Adapters, NetXteme Il Famiy... Important ~ Updates  3/18/2008 Engish & False T Goow o
Broadcom NetXuieme Il Base Driver DellUpdate Package, v... Important  Updates  3/18/2008 Engish False
Dell SA5 5/i Integrated, SAS 5/E Adapter, v.1.24.04.40,406  Crical Updates  3/18/2008 Engish ~ © False View ’
Dell SA5 5/i Integrated, SAS 5/E Adapter, v.1.24.04.40,A06  Crical Updates  3/18/2008 Engish True Delete
Dell S45 5/ and 6/ Adapter, SAS 5/R and 6/ Integrat... Important ~ Updates  3/18/2008 Engish False
Dell S45 5/ Integrated, SAS 5/R Adapter, v.1.24.04.40,A.. Important  Updates  3/18/2008 Engish False Rename
Broadcom NetXtieme Base Diiver Dell Update Package, v.1.. Important ~ Updates  3/18/2008 Engish & False Refresh
Dell S45 5/ and 6/ Adapter, SAS 5/R and 6/ Integrat... Important  Updates  3/18/2008 Engish & True
Dell S45 5/ Integrated, SAS 5/E Adapter, v.1.26.05.00,A00  Importart ~ Updates  3/3/2008 Engish ¥ True 2 Heb
Intel PRO PCI-E 4 Port Gigabit Base Driver, v.10.0, AD1 Important  Updates  3/3/2008 Engish False Dell OpenManage Inventory Agent(... «
Broadcom NetXtreme Family of Adapters, Netxtreme Il Family...  Important Updates  3/3/2008 Engish  © False
Broadcom NetXireme Base Diiver Dell Update Package, v.1... Important Updates  3/3/2008 Engish W Fakse & Export
Nall GAS B/i Intanratad GAG BIF Adanter w1 IR NENN ANN Imnardant lndstes 2229008 Ennlich W Tnia = Edi

Duplicate

Software Update Details +
& Clear Publish Flag

Update Dtails | Applicabilty Fules |
© Sset Expire Status »

] Dell OpenManage Inventory Agent X Delete
2@ Help

Update ID: R182910

Article ID:

Classifcation: Updates

Severity: Important

Creaion Date: 4/16/2008 11:48:49 AM

Language: Engish

Descption: Dell OpenManage Inventory Agent is a data provider for Mictasoft WMI to inventory information for Dell supported

devices. This service is un at boot time and then stopped automatically.
Publish Status: True.
Expite: False

[changes all SCUP compliant updates under selected node as flagged For publish.
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12. Next in the Actions Tree select Publish Updates; this will bring
up the Publish Wizard. A summary of the total number of updates
will be displayed, Click Next to begin downloading the updates
from the Internet.

Publish Wizard

gj Summary

_ Publishing will begin when you click 'Next',

Progress You are about to publish 474 update(s) with the following update server configuration:

Server: <Local>
Confirmation

< Previous I Mext = I Eimish

Cancel
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13. When completed, a confirmation will be displayed indicating up-
dates published or updates that failed to publish. As new Dell

updates are released, steps from 9 to 13 will need to be repeated.

Publish Wizard

gj Confirmation

Summary The approved updates have been published with the Following details:

Progress Successfully published 474 of 474 items to the update server,

Gonfirmatien:

< Brevious ext = Eiriish

This completes the publishing tasks needed to import Dell updates
into the WSUS environment. Continue to the next section to import
the Dell updates into SCCM.
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How to Use SCCM to Deploy the Updates

The next steps will cover importing updates from WSUS into SCCM,;
these steps assume SCCM is already setup and configured for the
environment. For information about how to setup SCCM, see the
Microsoft website at http://www.microsoft.com/systemcenter/
configmgr/default.mspx.

1. In SCCM under the Console Tree expand the Site Database >
Site Management > %Site Name% > Site Settings > Compo-
nent Configuration group and select the properties of the Soft-
ware Update Point Component.

B8 Configuration Manager Console =181
Fle Action Yiew Window Help | =181
e =] = ‘
(34 System Center Configuration Manager Component Configuration 5 items found Actions
=-E3 Site Database (CPP - PE2900-5CCM, PDK LAB) - —— | component Configuration A
145 Site Management Lookfor: | = | in [Al Columns | Find 1o Clear
-G CPP - POK LAB ‘@ Give Feedback
-8 Site Settings View »

2, Addresses Ttem Name |

1521 Boundaries (5 Management Point Component New Window from Here

{5 Client Agents 2 Software Distribution E

5% Client Installation Methods i e e

{3 Component Configuration 1) tatus Reporting Refresh 2 Help

B-L5) Certificates s

; 3’; okl (3% System Health Validator Point Component Software Update Point Component &

53 piscovery Methods Refresh

I senders = ,

-3 Site Maintenance Properties
£ Status Filter Rules @ Help
{23 Status Summary
Description .

-3 site Systems
{3 WPe2900-5CCM
-1 Computer Management
-G Collections
5L Conflicting Records
69 Software Distribution
-] Software Updates
=3 Update Repository
([ Search Folders
&3 Updates
{3 allupdates
=63 el
{3 Allupdates
% Bios
(23 Drivers and Applications
-5, Firmware
-5 Microsoft
{3 Update Lists
(-3 Deployment Templates
(23, Deployment Management
{3 Deployment Packages
<4 Operating System Deployment
4] Software Metering

- Reporting
#1-|47 Desired Configuration Management

-y, Queries
-[J7 Mobile Device Management
1€, Network Access Protection
{22 System Status
J-{iYy Advertisement Status
-{i]; Package Status
[ Site Status
-} CPP-PDKLAB
[ Component Status
[ Site System Status
{i} Status Message Queries
-3 Security Rights
-5 Tools

Settings to apply to all software update points
in this Confighlar site, like network loa
balancing and ports used.

|Opens the properties dialog box for the current selection.

distart| | (22 @ 4 |[& configuration Manag...

4:19PM
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2. The Software Update Point Component Properties screen will ap-

pear, switch to the Classifications tab and ensure Updates is

checked then click OK.

Software Update Point Component Properties

Generall Sync Settings  Classifications lProductsI Sync Schedulel Languagesl

Software updates in the specified classifications will be synchronized.

Update Classifications:

= [J Al Classifications
- [ Critical Updates
- [ Definition Updates
-~ [orivers
- [JFeature Packs
- [ security Updates
[ service Packs
~[OToals

[ Update Rollups

x|

| 0K I Cancel Apply

Help
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3. Switch to the Products tab and ensure Local Publisher is
checked then click OK.

Software Update Point Component Properties - 5]

Generall Spnc Setkingsl Classifications ~ Products | Sync Schedulel Languagesl

Software updates for the specified products will be synchronized.

Products:

Bl m]i Proucts.
&) [ Microsoft
=- [M] Local Publisher
L Locally published packages

| 0K I Cancel Apply Help
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4. In SCCM under the Console Tree expand the Site Database >
Computer Management > Software Updates > Update Re-
pository and right click Update Repository and select Run Syn-
chronization.

LIRS
(e amon vew wodw g | =loix
e am|@ |
5 ystem Contr Confaation Harager Actions

-3 Site Database (CPP - PE2300-5CCM, PDK LAB) Update Repository z
Lookfor: | | in [all Colurns | Find ow Clear .
[$] Run Synchronization

- Site Management
I ‘@ Give Feedback

= Computer Management

Collections
2L Conflicting Records

) Software Distribution
-5 Software Updates

Category

= 2 2 Wiew »
There are no items to show in this view.

New Window from Here

=8 Upd

13 Search Falde L P
(23 Update Lists Give Feedback =
{33 Deployment Temple o0y 5 Properties
5-(25, Deployment Mansg e,y window From Here @ Heb

3 Deployment Packag

4y Operating System Depl  Refresh
o-&n SoftwareMetering |

Repotting Properties

£ g Desired Configuration ! pyelp

L1 Queries
+-[§ Mobile Device Management
1% Network Access Protection
)22 System Status
-3 Security Rights
- Tools

4 | 2l
[ I
distart| | (2 @ 4 || configuration Manag... | 1 untitled - Paint 4:03PM
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5. A Run Update Synchronization pop-up will confirm running syn-
chronization, click Yes.

8 Configuration Manager Console.

=5[]
e e vew wedw ot =laixd
P |2 |
28 System Center Configuration Manager

Update Repository 0 items found
= ;l gnte Database (CPP - PE2900-SCCM, PDK LAB)

Actions
-3 site Management

L Conflicting Records

G5 View
G5 software Updates There are no items to show in this view.
=)-{% Update Repositary

Update Lists
Deployment Templates

. @ Help
[t} Deployment Packages

+] <4 Operating System Deployment
+-&n Software Metering

[
B
i Reporting
3] g Desired Configuration Management
{3y Queries

-7 Mobile Device Management

(-1 Network Access Protection

-2 System Status

-5 Security Rights

- Tools
Run Update Synchronization 1l x|
\i‘) Do you want o initate a site wide software update synchranization?
Synchranization progress can be reviewed via the SMS_WSLS_SYNC_MANAGER Componerit located within the Component Status node.
|
Rl | i
[action: In progress...

[ Run Synchronization

Update Repository
- Lookfor: | | in [all Colurins = Find 1o Clear
=153 Computer Management
B ?“:n Solectons — I @ Give Fesdback
= ategory.
[5)-£5§ Software Distribution
New Window from Here
{3 search Folders

Refresh

Properties
23 Deployment Management

distart| | (@ @ J |[ configuration Manag... 1 SCCM_Sync_Updatest. ..

6. To view synchronization status, navigate to Site Database > Sys-
tem Status > %Site Name% > Component Status >
SMS_WSUS_SYNC_MANAGER, and view all messages.

ConfigMgr Status Message Yiewer for

File Edit View Help

4:04 PM

HE & ‘ X l (N | () |]01igmalﬂuary

SMS WSLS Synchronization started.

<

El
Severity | T Site code Date { Time System Component Mess Description
@ v 5| M ] chronization done
@ Milestone 5/8/2008 4:13: PE2900-5CCM SMS_WSUS_SY 6705 SMS WSIS Synchronization in progress. Current phase: Synchronizing SMS Database.
@ Milestone: CPP 5/8/2008 4:12:41 PM PE2900-5CCM SMS_WSUS_SY... 6701

Command Query : 3 of 3 messages displayed. 1 selected.
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88 Configuration Manager Console i

7. Once synchronization has completed, navigate to Update Re-

pository, right click and refresh. Then navigate to Site Database
> Computer Management > Software Updates > Update Re-
pository > Updates > Dell > All Updates; all published updates
should now be visible.

5 Fle Action View Window Help

=18(x|

JSE

& 9|

@ em

5 System Center Configuration Manager
2 Site Database (CPP - PE2900-SCCM, PDK LAB)

=) Site Management
=4 CPP-PDKLAB
£ Site Settings
2 Addresses
{121 Boundaries
13 Client Agents
[ Client Installation Methods
i3 Component Configuration
=) Certificates
LB} Accounts
L3 Discovery Methods
[ Senders
[ Site Maintenance
[ status Filter Rules
7 Status Summary
ite Systems
VWPE2900-5CCM
A Computer Management

oG Collections

% Conflicting Records
79 Software Distribution
=% Software Updates

&

=-£33 Update Repository
£33 Search Folders
-6 Updates

B

-, Firmware
-5 Microsoft
{33 Update Lists
(£33 Deployment Templates

All Updates 221 items found

Lookfor: | 2|

4| Fird Mow Clear

[ Date Released 4

Bulletin ID__| Title
R182910  Dell OpeniManage Inventory Agent

J[R182895  DellBMC Fitmware, v.2.05, A09
T]R182898  Dell BMC Firmware, v.2.05, A1D
J|R182899  Dell BMC Firmware, v.2.05, A1l
T]R182892  Dell BMC Firmware, v.2.06, ADS
"[R182890  Dell BMC Firmware, v.2.03, A7
"[R182889  Dell BMC Firmware, v.2.03, AD7
"TR182891  Dell BMC Firmware, v.2.06, AD7
TR182834  Dell BMC Firmware, v.2.06, A07
Dell Powervault 110T LTO-2-L (Tandberg), v.03.76, A-00
Dell Remote Access Controller - DRACS, v.1.33, AQD

J[R178174  Dell CERC 6/i Integrated, v.6.0.2-0002, A03

JIR183699  Dell OpenManage Server Administrator Managed Node, v.5.4.0, ADL

J[R170419  Dell SAS 5/iR and 6/R Adapter, SAS /iR and 6/iR Integrated, SAS 6/IR Inteqrated Blades, v.1.24.04.40, A0S
Z]R177923  Broadcom NetXtreme Family of Adapters, Nettreme 11 Family of Adapters, v.12.0, ADD

J[R177925  Broadcom Netitreme Family of Adapters, Netxtreme II Family of Adapters, v.12.0, ADD

g jRUEl?l Dell PERC 6/E Adapter, v.6.0.2-0002, A03
le?Bl?Z Dell PERC 6/i Integrated, v.

0.2-0002, AD3

TTR176960  Dell 5A5 6/iR Adapter, v.00.20.48.00.06.14.10.00 , A03
leTEQSB Dell 5AS 6/iR Integrated, v.00.20.48.00.06.14.10.00 , AD3
leTE‘?S‘? Dell SAS 6/IR Integrated Blades, v.00.20.48.00.06.14.10.00 , A03
“/R170420  Dell SAS S{iR and 6iR Adapter, 5AS 5/iR and 6/iR Integrated, SAS 6/IR Integrated Blades, v.1.24.04.40, A0S
CTR170421  Dell SAS S/iR Inteqrated, SAS S{iR Adapter, v.1.24.04.40, ADS
JIR176235  Dell 5AS S/i Integrated, SAS S/E Adapter, v.1.24.04.40, AG6
DIR176232  Dell 5AS 5ji Integrated, SAS S{E Adapter, v.1.24.04.40, AD6

D]R170409  Dell SAS 5/i Integrated, v.1.24.04.40, ADS
= i
<«

|

{23 Deployment
£33, Deployment Packages

4 Operating System Deployment
-4 Software Metering

:{%

Dell OpeniManage Inventory Agent

Status | Content Information | Supersedence Information

4/16{2008 4:48..
4/16/2008 11:4..
4/16/2008 11:4..
4{16/2008 11:4..
4{16/2008 11:4..
4{16/2008 11:4..
4{16/2008 11:4..
4/16/2008 11:4..
4/16/2008 11:4..
4/15/2008 2:08..
4/15/2008 12:3..
4/14/2008 8:09..
4/10/2008 12:0..
4/4{2008 12:42..
3/18/20087:23..
3/18/2008 7:22..
3/18/2008 7:18..
3/18/2008 7:17..
3/18/20087:16..
3/18/2008 7:15..
3/18/2008 7:15..
3/18/2008 7:13..
3/18/2008 7:10..
3/18/2008 7:09..
3/18/2008 7:08..

3/18/2008 7:0 _I:J
: »

- Reporting

14 Desired Configuration Management
o, Queries

-7 Mobile Device Management

- Network Access Protection

(22 System Status
-3 Security Rights

-5 Tools

Bulletin ID: R182910
Article ID:

Date revised: Wednesday, April 16, 2008
Maximum severity rating: Important
Description:

Dell Openianage Inventory Agent is a data provider for Microsaft WHMI to inventory information for Dell supported devices. This service
is run at boot time and then stopped automatically.

Applicable languages:
Englsh

Affected products:
Drivers and Applications

Actions

All Updates )

@ Give Feedback
View »
New Window from Here
Refresh
@ Help
Dell OpenManage Inventory Agent  «
] Deploy Software Updates
[#] Download Software Updates
(4 Update List
Copy
Refresh
Properties
2@ Help
Description -

Dell Opentanage Inventary Agent
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8. Under the All Updates section locate the Dell OpenManage In-
ventory Agent and take notice of the compliance state where all
client systems will be evaluated to unknown.

n Manager Console

5 Fle Action View Window Help

e~ @@ 2
[ System Center Configuration Manager All Updates 222 items found Actions
= ;l Elte D.atahase (CPP - PE2900-SCCM, PDK L All Updates
-1+ Site Management Lookfor: [ in [All Colurns | Fird o Clear
CPP - PDK LAB ‘@ Give Feedback
-4 Computer Management e
=5 Collections Bulletin ID [ Title [ % Compliant [ Installed | Required | Not Required
-8 All Active Directory Security Gro |[ ST R182310  Dell Openianage Inven...  0.00% 0 0 0 s s Important New Window from Here
58 AllDesktops and Servers TIR182895  DellBMC Firmware, v.2.... 0.00% 0 0 0 s 5 Important  NjA Refresh
& Al Systems TTR182898 Dell BMC Firmware, v.2. 0.00% 0 [} 0 5 s Important  NfA
5 AllUser Groups TR182899  Dell BMC Firmware, v.2.... 0.00 % 0 0 0 s 5 Important  NfA 2 Help
; i:: x:;iws 2000 Professional || I RI82892  DellBMC Firmmare, v.2.... 0.00% 0 0 0 s 5 Important  NjA
g8 Al Windows 2000 Server Syste [R182890  DellBMC Firmware, v.2.... 0.00% 0 0 0 5 5 Important  NjA
; Al Windows Mabile Devices leEZEBQ Dell BMC Firmware, v.2. 0.00 % 0 ) 0 S s Important  NjA
Bl ; All Windows Mobile Packet PC 2 j R182891 Dell BMC Firmware, v.2. 0.00 % 0 0 ] S S Important  NjA
; Al Windows Mabile Pocket PC 5 j R182894 Dell BMC Firmware, v.2. 0.00 % o 0 0 S S Important  NjA
- All Windows Mobile Smartphone || (2 R168250  DellPowervault 110TLT... 0.00% 0 0 0 5 5 Important  NjA
2 AllWindows Mobile Sartphone || Z]R182768  Dell Remote Access Con... 0.00% 0 0 0 5 5 Important  NjA
(g All Windows Server 2003 Syste || ZIRI78174  Dell CERC 6/i Integrate...  0.00% 0 0 0 s 5 Important  NjA
& All windows Server Systems “[R183699  Dell OpenManage Serve... 0.00% 0 0 0 5 5 Moderate  NjA
B All Windows Workstation or Pra || ZTR170419  Dell SAS /iR and 6/R A...  0.00% 0 0 0 5 5 Important  NjA
& All Windows XP Systems [R177923  Broadcom Netxtreme Fa... 0.00% 0 0 0 5 5 Important  NjA
5 Conflicting Records TIR177925  Broadcom Netxtreme Fa... 0.00% 0 0 0 s 5 Important  NjA
(-85 Software Distribution Slr178171 Dell PERC 6/E Adapter, ... 0.00 % 0 0 0 5 5 Important  NjfA
B Software Updates Slri78172 Dell PERC 6i Integrated... 0.00 % 0 0 0 5 5 Important  NjA
EI-§, Update Repository ST R176960 Dell A5 6/iR Adapter, v... 0.00 % 0 0 0 5 5 Important  NjA
-G Search Folders TIRI76968  Dell SAS 6/R Inteqrated... 0.00% 0 0 0 s 5 Important  NjA
-0 Undates TTRI76969  Dell SAS 6/IR Inteqrate...  0.00% 0 0 0 s 5 Important  NfA
g ey ~[R170420 Dell 545 5/R and 6{iR A... 0.00 % 0 0 0 5 5 Important  Nj&
s 3 M::msuﬂ J[R170421  Dell SAS SR Integrated... 0.00% 0 0 0 5 5 Important  NjA
£ Update Lists R176235  Dell 545 SfiIntegrated, ... 0.00% 0 0 0 5 5 Critieal  NjA
-3, Deployment Templates R176232  Dell5ASSfiIntegrated, ... 0.00% 0 0 0 5 5 critieal  NjA
B Deployment Management ZIR170409  Dell 5AS Sji Integrated, ... 0.00% 0 0 0 5 5 Important  NjA
5623, Deployment Packages $1R178325  DellServerBIOS, 1.4.0  0.00% 0 0 0 5 5 Important  NjA
-4y Operating System Deployment STR178424 Dell Server BIOS, 1.4.3  0.00% 0 0 0 5 5 Important  NjA
&a Software Metering j R178423 Dell Server BIOS, 1.4.4 0.00 % 0 ) 0 S s Important  NjA
] g Reporting S|R178444 Broadcom Netitreme Ba... 0.00 % 0 0 0 5 5 Important  N/A
{2 Desired Configuration Management || 5]R178443  Broadcom Netxtreme I1...  0.00% 0 0 0 5 5 Important  NjA
{3y Queries J[R178442  Broadcom Netxtreme Ba... 0.00% 0 0 0 5 5 Important  NjA
§” Mobile Device Management ST R178441 Broadcom NetXtreme II... 0,00 % 0 0 0 5 5 Important  NjA
11655 Network Access Protection “TR179941 Dell PowerYault RD1000...  0.00 % 0 0 0 5 5 Important  Nf&
% System Status TTR180605 Dell DRAC v1.0, v.1.02...  0.00 % 0 [} 0 5 s Important  NfA
Ee-ER Security Rights TRI80606  Dell DRAC v1.0, v.1.02... 0.00% 0 0 0 s 5 Important  NfA
- Tools FIR177926 Broadcom Netitreme Fa... 0.00 % 0 0 0 5 5 Important /A
[R177924  Broadcom Netxtreme Fa... 0.00% 0 0 0 5 5 Important  NjA
le7Bﬂ5EI Broadcom NetXtreme Ba... 0.00 % 0 ) 0 S s Important  NjA
j R178048 Broadcom NetXtreme IT ...  0.00 % 0 0 ] S S Important  NjA
j R17801S Intel PRO PCI-E Gigabit ... 0.00 % o 0 0 S S Important  NjA
TIR178021  Intel PRO PCIE Gigabit ... 0.00% 0 0 0 5 5 Important  NjA
JJR178022  IntelIntel PCI-E 10Gig a... 0.00% 0 0 0 5 5 Important  NjA
J[R178024  IntelIntel PCI-E 10Gig a... 0.00% 0 0 0 s 5 Important  NjA
“[R178025  Intel PRO PCLE Gigabit ... 0.00% 0 0 0 5 5 Important  NjA
jl'ansoaa Intel PRO PCIE Gigabit ... 000 % 0 . 0 0 5 5 Important  NjA _'_I
K ——| .
[
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9. After clients perform their next software update scan cycle, the
OpenManage Inventory Agent applicability will be reported to the
SCCM site.

B

E

%] Software Updates

B, Queries

-18] x|
FrE
) Addresses AEtions
13 Boundaries All Updates =

{33 Cliert Agents
153 Client Installation Methc
£ Component Configuratic
B-L5) Certificates
(B, Accounts
L piscovery Methods
I senders
B3 Site Maintenance
{2 status Filter Rules
{23 Status Summary
-5 Site Systems
{3 WPE2900-50cCM
7 Computer Management

.48 Collections
2 Conflicting Records

£ Software Distribution

=-£23 Update Repository
{33, search Folders
=103 Updates
3 Allupdates
=63 el
{33 allUpdates
3 Bios
Drivers and App
(2, Firmware
23 Microsoft
Update Lists

£33 Deployment Packages
J Operating System Deployment
& Software Metering
- Reporting

(3, Dashboards

123 Reports

£ Visited Reports

@[3 Compliance 1 - Overall C
Management 1 - Update
States 1 - Enforcement
Scan 1 - Last scan state
Compliance 7 - Specific ¢
[ Compliance 6 - Specifc ¢
#1-{Y Desired Configuration Managem

=]
@
=]
@

E-E-E-E-E-E

#-f§7 Mobile Device Management
- Network Access Protection
%) System Status
+).{i%y Advertisement Status
.41, Package Status
- [53 Site Status

=) CPP-PDKLAB

[ Component Status
= ouip it El

Lookfor: [

Bulletin ID

'R182910
JIR182895
JTR182898
J[R182899
JTR182892
7 R182890
| R182859
JTR182891
JTR182894
51 R168250
>IR182768
JIR178174
JTR183699
JTR170419
STR177923
JTR177925
STR178171
JTR178172
JTR176960
JIR176968
>IR176969
>|R170420
>IR170421
JIR176235
JTR176232
STR170409
JTR178325
S R178424
S R178423
S R178444
JTR178443
JIR178442
STR178441
STR179941
JTR180605
)[R180606
STR177926
JTR177924
7 R178050
| R178048
JIR178015
>IR178021
>IR178022
JIR178024
JTR178025
?R 178033

4

Dell OpenManage Inventory Agent
Dell BMC Firmware, v.2.05, A0S
Dell BMC Firmware, v.2.05, A10
Dell BMC Firmware, v.2.05, ALL
Dell BMC Firmware, v.2.06, A0S
Dell BMC Firmware, v.2.03, AD7
Dell BMC Firmwiare, v.2.03, A07
Dell BMC Firmware, v.2.06, A07
Dell BMC Firmware, v.2.06, A7
Dell Powervault 110T LTO-2-L (T...
Dell Remote Access Controller - ...
Dell CERC 6{i Integrated, v.6.0.
Dell Opentanage Server Admini
Dell SAS S{iR and 6/iR Adapter, ...
Broadcom Netxtreme Farnily of A...
Broadcom Netxtreme Farnily of A...
Dell PERC 6/E Adapter, v.6.0.2-...
Dell PERC 6/i Integrated, v.6.0....
Dell SAS 6/R Adapter, v.00.20.4...
Dell 545 6/iR Integrated, v.00.2...
Dell 545 6/IR Integrated Blades, ...
Dell 545 S/iR and 6/iR Adapter, ...
Dell SAS SfR Integrated, SAS Sfi...
Dell SAS Sl Integrated, SAS S(E ...
Dell SAS S Integrated, 5AS S/E
Dell SAS S Integrated, v.1.24,
Dell Server BIOS, 1.4.0

Dell Server BIOS, 1.4.3

Dell Server BIOS, 1.4.4
Broadcom Netitreme Base Drive...
Broadcom NetXtreme II Base Dri...
Broadcom NetXtreme Base Drive...
Broadcom NetXtreme II Base Dri...
Dell Powertault RD1000 Internal...
Dell DRAC v1.0, v.1.02, AD4

Dell DRAC v1.0, v.1.02, A03
Broadcom Netxtreme Farnily of A...
Broadcom Netxtreme Farnily of A...
Broadcom Netitreme Base Drive...
Broadcom Netitreme II Base Dri.
Intel PRO PCI-E Gigabit Family of ..
Intel PRO PCI-E Gigabit Family of ..
Intel Intel PCI-E 10Gig and 1Gig ...
Intel Intel PCI-E 10Gig and 1Gig ...
Intel PRO PCI-E Gigabit Single ar
Intel PRO PCI-E Gigabit Single ar

0.00 %

Important

0.00 %
0.00 %
0.00 %
0.00 %
0.00 %
0,00 %
0,00 %
0.00 %
0.00 %
0.00 %
0.00 %
0.00 %
0.00 %
0.00 %
0.00 %
0.00 %
0,00 %
0.00 %
0.00 %
0.00 %
0.00 %
0.00 %
0.00 %
0.00 %
0.00 %
0.00 %
0.00 %
0,00 %
0.00 %
0.00 %
0.00 %
0.00 %
0.00 %
0.00 %
0.00 %
0.00 %
0.00 %
0,00 %
0,00 %
0.00 %
0.00 %
0.00 %
0.00 %
0.00 %
0.00 %

OO0 O0 o000 OO0DO0O0O0O0DO0O0O00O0O00DO0NO0000O000000000000G0O00 O

Important
Important
Important
Important
Important
Important
Important
Important
Important
Important
Important
Moderate
Important
Important
Important
Important
Important
Important
Important
Important
Important
Important
Criical

Criical

Important
Important
Important
Important
Important
Important
Important
Important
Important
Important
Important
Important
Important
Important
Important
Important
Important
Important
Important
Important
Important

Date Released
4{16{2008 4:4¢
4/16/2008 11:¢
4/16/2008 11:¢
4/16/2008 11:¢
4/16/2008 11:¢
4/16/2008 11:¢
4/16/2008 11:¢
4/16/2008 11:¢
4/16/2008 11:¢
4/15/2008 2:01
4/15/2008 1
4/14/2008 8:0¢
4/10/2008 12:0
4/4{2008 12:42
3/18/2008 7:2¢
3/18/2008 7:2:
3/18/2008 7:1¢
3/18/2008 7:17
3/18/2008 7:1¢
3/18/2008 7:1¢

3/18/2008 7:1¢
3/18/2008 7:0¢
3/18/2008 7:0¢
3/18/2008 7:0¢
3/18/2008 2:3¢
3/18/2008 2:3¢
3/18/2008 2:3¢
3/18/2008 2:20
3/18/2008 2:1¢
3/18/2008 2:1¢
3/18/2008 2:1¢€
3/18/2008 2:0¢
362008 8:53
3/6{2008 8:52
3/3(2008 10:3¢
3/3(2008 10:3¢
3/3(2008 9:54
3/3(2008 9:51
3/3/2008 3:39
3/3/2008 3:38
3132008 3:37
3/3(2008 3:35
3/3(2008 3:34

3/3/2008 i':]

‘@ Give Feedback
View

New Window from Here

Refresh

@ Help
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10. Next select the Dell OpenManage Inventory Agent update then
click Action > Deploy Software Updates.

e
5 File | Action View Window Help |_s|_x_|

re Updat:
Download Software Updates =
o [t it [o——
i all dates -
Copy Lookfor: | in [all Columns =l Fird oy Clear b
£ Refresh ‘@ Give Feedback
Properties Wiew k
Help R 0 Del age I y Agent 0 5 Important  4{16] 148 New Window from Here
‘7 R182895 Dell BMC Firmware, v.2.05, A09 0.00 % o o 0 s S Important  4/16/2008 11:< Refresh
2 lent Instalation Methc TTR182898  DellBMC Firmware, v.2.05, AI0 0.00% 0 0 0 5 S Important 4/16/2008 11:¢
& Component Configuratic JIR182899  Dell BMC Firmware, v.2.05, A1l 0.00 % 0 0 0 5 5 Important 4/16/2008 11:¢ 2 Hep
LE ;:Z:::;es )|R182892  Dell BMC Firmware, v.2.06, A0S 0.00% 0 0 0 s 5 Important 4/16/2008 11 | pell openManage Inventory Agent
5 Discovery Methods 7|R182890  Dell BMC Firmware, v.2.03, 07 0.00% 0 0 0 5 i || F=amram———
B senders J[R182889  Dell BMC Firmware, v.2.03, 07 0.00% 0 0 0 5 S Important 4/16/2008 11:¢ 4
B JIR182891  DellBMC Firmware, v.2.06, 407 0.00% 0 0 0 s 5 Important /162008 11:¢ | [§] Download Software Updates
5 Status Fier Rules [R182894  Dell BMC Firmware, v.2.06, A07 0,00 % 0 0 0 s S Importent 4100810 |
B2, Status Summary "IR163250  DellPowervault 1107 LTO-2-L (T... 0.00% 0 0 0 s 5 Important 4/15/20082:0¢
&g st systems JIR182768  DellRemate Access Controller -...  0.00% 0 0 0 s 5 Important 4/15/2008 12:2 Copy
£ \\PE2900-5CCM J[R178174  Dell CERC 6fi Integrated, v.6.0. 0.00 % 0 0 0 5 5 Important  4/14{2008 8:0¢ Refresh
= La Computer Management j R183699 Dell OpenManage Server Admini 0.00 % o o 0 s s Moderate  4/10/2008 12:C
-5 Collections JIR170419  Dell SAS /R and 6/iR Adapter, ...  0.00% 0 0 0 5 5 Important  4/4/2008 12:42 Properties
L Conflicting Records JIR177923  Broadcom Netitreme Family of A... 0.00 % 0 0 0 5 5 Important 318{20087:2% | (@
-5 Software Distribution J[R177925  Broadcom Netxtreme Family of ... 0.00% 0 0 0 s 5 Important 3(18/20087:2:
55 Software Updates J[R178171  Dell PERC 6/E Adapter, v.6.0.2- 0.00% 0 0 0 5 5 Important  3{18{2008 7:1¢ Description )
{5 Update Repository JIR178172  Dell PERC 6fi Integrated, v.6.0. 0.00% 0 0 0 5 5 Important  3{18/2008 7:17 Dell OpeniManage Inventory Agent
W search Fodars TTRI76960  Dell SAS 6fiR Adapter, v.00.20.4... 0.00 % 0 0 0 5 S Important 3/18/2008 7:1¢
5+ Updates J[R176968  Dell SAS 6/R Integrated, v.00.2...  0.00% 0 0 0 s S Important 3({18/20087:15
3 Alupdates JTR176969  Dell SAS 6/IR Intearated Blades,... 0.00% 0 0 0 5 5 Important
e et R 7R170420  Dell 545 5/R and /R Adapter, ...  0.00% 0 0 0 s 5 Important 3{18/20087:13
& t,g S JR170421  Dell 545 SR Integrated, SAS 5fi... 0.00% 0 0 0 s 5 Important 3/18/2008 7:1¢
g >IR176235  Dell 5AS Sfi Integrated, SASS/E ... 0.00% 0 0 0 5 5 Critical  3/18/2008 7:0¢
(23 Drivers and App
02 Fimware JIR176232  Dell 5AS Sfi Integrated, SASS/E ... 0.00% 0 0 0 5 5 Critical  3/18/2008 7:0¢
623, Mirosoft 1;«170409 Dell SAS Sji Inteqrated, v.1.24.0... 0.00% 0 0 0 5 5 Important 3(18/2008 7—|_,
) Update Lists 4] | »
Deployment Templates
% Deployment Management Update Details | Deployment Status | Content Information | Supersedence Information
£33 Deployment Packages
(-4 Operating System Deployment ﬁ Dell Opentanage Inventory Agent
- Software Metering
=~ Reporting
A D=fimords Bulletin ID: R162910 -
13 Reports Article 1D:
12 Visited Reports
-B1 Compliance 1 - Overal ¢ Date revised: Wednesday, April 16, 2008
B2 Management 1 - Update Maximum severity rating: Important
#-E3 States 1 - Enforcement |
[ Scan 1 - Last scan state Description:
£ Compliance 7 - Spe Dell OpeniManags Inverttory Agent is a dats provider for Microsoft WHI to inventory information For Dell supported devices, This service i run at
gy boot time and then stopped automatically.
{59 Desired Configuration Managem Applicable languages:
5 Queries Englsh
[ Mobile Device Management et
+-16 Network Access Protection g
T B, Sy e _ Drivers and Applications
FE el LIJ
Deploy Software Update(s) to a collection, [

Aistart| | (2 @ 4 || configuration Manag... Y untitled - Paint | 53 ci\pocuments and settin... 51 PM
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11. The Deploy Software Updates Wizard will appear. Click Next for
the default deployment name.

Deploy Software Updates Wizard

A
gj General

Deployment Template

Enter a unique name and detailed description that will help identify the software update deployment

Deployment Package Mame:

Download Location

|Dell Updates - 5{12/2008 2:08:47 PM (DSIA)
Language Selection

Schedule
Set NAP Evaluation ..:.I

Description:

Summary
Progress

Confirmation

< Brevious " MNext = I Einish Cancel
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12. Use an existing deployment template or create one per the envi-

ronments settings, click Next.

Deploy Software Updates Wizard

gg Deployment Template

General
Deployment Package
Download Location

Language Selection

Templates can be used to define deployment properties, such as target collection, package, and client
settings. The properties can also be manually configured within the wizard and optionally saved as a

template for future use in other deployments.

Select a template or define new properties for the software update deployment:

Schedule
Set MAP Evaluation
(" Create a new deployment definition
Summary
Progress &« iUse an existing template : Details:
Gonfrmation < Default Deployment Suppress Restart: _A_I
MNone
Allow system restart outside of main!
Enabled
Windows Event Generation:
Enabled
Disable Window E vent while update
Enabled
SMS 2003 Deployment:
Disabled
v
< | »
< Previous " MNext = I Finisty Cancel
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13. Select a deployment package or create one per the environ-
ments settings, click Next.

Deploy Software Updates Wizard

; Deployment Package

I~ Eniatile binary differential replication
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14. Select “Download software updates from the Internet”, then

click Next.

Deploy Software Updates Wizard

Download Location

General
Deployment Template
Deployment Package

| Dowrloadlocation
Language Selection
Schedule
Set MAP Evaluation

If your site server does not have an Internet connection, you can download the software updates
from a different computer and save them to a network location accessible by the site server,

Select the download location for software updates:

* ‘Downioad software updates from the Internet

" Download software updates from a location on the local network

Summary I Brawse.
Progress
Confirmation MNote:
When the deployment package contains all required software updates, select the "Download
software updates from the Internet” option. The software updates files will be validated, but will not
be downloaded again.
< Previous " Next = I Firish Cancel
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15. Check “English” from the language selection, then click Next.

Deploy Software Updates Wizard

grg Language Selection

General

Deployment Template

Software update files are downloaded for each language specified in the Update File column,

Peposeot Pac.kage Language | Update File [
Download Location — r
_ Chinese {Hong Kong 5.A.R.)} C
schedde Chinese (Taiwan) o
Frtl MR e Chinese {People's Republic of China) |
Summary Coech O
Progress Danish O

Confirmation butch r o
Finnish r
French |
German ()
Greek [
Hebrew r
Hungarian O
Italian r

1 | 24

< Previous “ MNext = I Finisty Cancel
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16. Set the schedule for when the software updates should be de-
ployed, then click Next.

Deploy Software Updates Wizard 77

Deployment Schedule

General Select the date and time that software updates will be made available to clients:
Deployment Template
Deployment Package (% &s sgon as possible
) " Date and time
Download Location -
5/12{2008 Y. 212 PM =
Language Selection I 12l —] I =]

_ Specify whether the software updates should automatically install on clients at a configured

deployment deadline:

Set MAP Evaluation
summary " Do not set a deadline for software update installation
Progress
Confirmation (% Set a deadline for software update installation
| st12/2008 || 2@ -

Specify whether at deadline Wake On LAN will be used to send wake-up packets to computers
that require updates in this deployment.

™ Enable Wake On LAN

If the software update is urgent, it can be installed immediately at the deadline, regardless of
configuration maintenance windows.

™ Ignore maintenance windows and install immediately at deadline

< Previous ” MNext = I FEinisty Cancel
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17. Select the desired settings for NAP evaluation per the environ-
ment, then click Next.

Deploy Software Updates Wizard i

Set NAP Evaluation

General

Deployment Template

MNetwork Access Protection (MAP) in Configuration Manager works with Windows Network Policy
Server to enforce compliance of selected software updates. The software updates in this deployment
can be included in a NAP evaluation.

Deployment Package
Download Location
Language Selection i
Schedule :
_ Specify when these policies become effective,
Summary {* s soom as possible
Progress (¢ Date and time
contieen | stz6r2008 1| z13em —

i) When the policies become effective, clients might have restricted network access until they
comply with the selected software updates. Network restriction and remediation are dependent
on how the policies are configured on the Windows MNetwork Policy Server.,

< Previous " MNext = I Finish Cancel
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18. Review the summary and click Next. Then review the confirma-
tion and click Close.

Deploy Software Updates Wizard ) _5[

Wizard Completed

General

Deployment Template
Deployment Package
Download Location
Language Selection
Schedule

Set NAP Evaluation
Summary

Progress

Gonfirmation.

@ The Deploy Software Updates Wizard completed successfully,

Details:

' Ipdates Targeted: A
+ Dell OpenManage Inventory Agent

@ Success: General:
+ Deployment Name: Dell Updates - 5/12/2008 2:08:47 PM {DSIA)
Template Selection:
* An existing template will be used:Default Deployment
Computer Systems Targeted:
+ Collection: all Systems
+ Include members of sub-collections:Yes
Deployment Attributes
+ Display balloon reminders and installation progress:Yes
Deployment schedules will be based on:UTC
If a restart is required it will be:Allowed
If a restart is required outside of a maintenance window it will be: allowed
Mandatory install time will, by default, be offset by: 2 Weeks =
On update installation error generate a Window Event:Yes
Disable Window Event while updates install:No
Update Binary Download:
+ Computers can retrieve content from remote distribution points: Yes
+ Computers can fallback to unprotected distribution points:Yes
SMS 2003 Deployments:

* SMS 2003 deployments will be generated:No Ll
To close this wizard, click Close.

< Preyious I [iext > Einish l | Close I
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19. To review the software deployment or make changes, go to Site
Database > Computer Management > Software Updates >
Deployment Management > %Deployment Name%.

Configuration Manager Console

=18(x|
) Fle Action View Window Help | —18(x]
e amE 2
2 System Center Configuration Manager | peployment Management s found Actions
=23 Site Database (CPP - PE2900-SCCM, PDK LAB) T =
E1-5 Site Management Lookfor: | =] in Al Columns =l Endiow Clear
=& cPp-POK LAB ‘@ Give Feedback
= [ Site Settings
View »
2 Addresses
{1 Boundaries New Window from Here:
{3 Client Agents
54 Client Installation Methods Refrest
{2 Component Configuration Properties
2 Certicates
B Accounts B relp
L5 Discovery Methods Dell Updates - 5/12/2008 2:08:47 P... ~
Senders
[ Site Maintenance X Delete

{2 Status Filter Rules
{2 Status Summary
Site Systems
{5 wpe2900-5CCM
= Computer Management
oG Collections
2 Conflicting Records
[#-55§ Software Distribution
-5 Software Updates
[=1-[) Update Repository
{3 search Folders
=-£3 Updates
{3 Allupdates
=6 Dell
{3 Allupdates

(-2 Drivers and Applications
{5 Firmware
-£3, Microsoft
{3 Update Lists
3 Deployment Templates
=1-{23, Deployment Management
5MS2003 Advertisements
5] % Dell Updates - 5{12/2008 2:08:47 PM (DSIA)
3 software Updates
Deployment Packages
% Default Package
[0y Operating System Deployment
+- & Software Metering
= Reporting
(24, Dashboards
[ Reports
=-[ Visted Reports
-2 Compliance 1 - Overall Compliance
Management 1 - Updates required but not de
States 1 - Enforcement states For a deploym
Scan 1 - Last scan states by collection
Compliance 7 - Specific software update stat
[ Compliance 6 - Specific computer
{9 Desired Configuration Management
it ol |

E-E-E-E-E

@
=]
@
=]
@

Refresh

Properties

@ Help

distart| | (22 @ 4 |[5 configuration Manag... 1§ untitled - Paint

d) Software Update Installation

A software updates deadine has been exceeded and update
4 installation will soon begin. A restart might be enforced when
installation completes. Click here to install updates now.

x]

l \_J) C:\Documents and Setti

5:01 PM
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20. After the Dell OpenManage Inventory Agent has been installed
on the SCCM Dell managed clients and the Dell Updates are re-
evaluated, the compliancy of Dell updates will reflect what pack-
ages have been installed and what packages require update.

88 Configuration Manager Console

=18(x|

5 Ele  Action WView Window Help

[T

- aE el

System Center Configuration Manager All Updates 221 items found Actions

=123 Site Database (CPP - PE2900-5CCM, PDK LAB) Allpdates
in [l Columns =0 Endiow Clear
‘@ Give Feedback

+}- L2 Site Management Look for: |
=15 Computer Management .

{22 System Status

5.3 Security Rights J[R180080  Adaptec CERC SATALS{6ch, v.4.1.1,7043, ...  80.00%

JIR177588  Dell SAS 5iR and 6/ Adapter, SAS SjiR and ... 80.00 %

000 0000000000000 O0O0O00O0O0O00O0000CO0O0O0O0O OO O o oSNNI
~moOr-roOOO~OOODCOO~OOOOOOCOOOOCOOOOCOOOOCOO=00O0
L R O N S N N S S N S N N O N N S N N N N N N (I N X YN QY

-5 Tools
>[R177587  Dell 5AS 5/iR and 6/iR Adapter, SAS /R and ... 80.00 %
jR178453 Dell Server BIOS 106G, 2.2.6 80.00 %

L: le?ﬁﬂS Dell Server BIOS, Server BIOS 10G, 2.2.6 80.00 %
jR178133 Dell Server BIOS 106G, 1.1.0 80.00 %
[: le?UZZO Dell Server BIOS, 1.0.0 80.00 %
jR17ﬁ434 Dell Server BIOS, Server BIOS 10G, 2.2.6 80.00 %
le?&‘%ﬁO Dell Server BIOS, 2.2.6 80.00 %
le?E'%ZT Dell Server BIOS, Server BIOS 10G, 2.2.6 60.00 %
JIR168343  Hitachi 3.5", 15K, SAS, 73GB, DU, 3.5", 15K, ... 80.00 %
leSB‘}EU Dell SAS SJE Adapter, v.00.10.51.00,06.12.0... 80,00 %
leEB‘\77 Dell SAS Sfi Integrated, v.00.10.51.00.06.12... 80.00 %
J[R168472  Dell 5AS 5/iR Integrated, v.00.10.51.00.06.1... 80.00 %
J[R168387  Adaptec PERC3/DI, v.2.8.1.7692, A3 80.00 %
©7R168380  Adaptec PERC3/DI, v.2.8.1.7692, A13 80.00 %
[: jR169302 Dell PERC 5/i Integrated, v.5.2.1-0067, A07 60.00 %
[: jR169023 Dell Server BIOS, 1.4.2 80.00 %
leSESH Dell Powervault LTO4-120HH (IBM), v.7A31, ...  80.00 %
k: jR165745 Dell PERC S(E, Sfi, 6/E, 6/i Adapter, 5fi, 6fi In... 80,00 %
jR155739 Dell PERC S(E, Sfi, 6/E, 6/i Adapter, 5fi, 6fi In... 60,00 %
[: leSBWl Dell SAS SfiR Adapter, v.00.10.51,00.06.12.... 80,00 %
le?BlEl Dell BMC Firmware, v.1.79, A00 80.00 %
>[R171043  Dell 5AS Backplane Firmware, v.1.06, A00 60.00 % "_I
K | <

3l % Collections o]
Confiicting Records i i i i
+|- 85§ Software Distribution New Window from Here
.45 Software Updates
EL‘::/ Update Repository Refresh
{3 Search Folders @ Help
=103 Updates
E Selected Items
Sl el Ri6asis mo ntroller - DRAC 4/1, 8 3 Deploy Software Updates
63 Bios 5]R169446  Dell Server System BIOS, ADS 80.00% [#] Download Software Updates
% 3 Drivers and Applications || 2 R170407  Dell 545 SIE Adapter, v.1.24.04.40, ADG 80.00% () Updatetist
b e BIR173922  Dell PowerVault LTO3-060 (Tandberg), v.3.8...  80.00 % :
-8 Merosoft [R172182  Dell 5AS Backplane Firmware, v.1.06, ADD 60.00% Copy
23, Update Lists SIR175282  Dell Server BIOS 10G, 1.0.0 80.00 % Refresh
& ‘E) Deployment Templates [ leSB‘}EU LSI Logic L512032, v.1.03,39.00.5.10.08.00.... 80.00 %
{23 Deployment Management J[R168404  Seagate T10,10K,5453.0,3.5", 146GB,5GT3,...  80.00 % Properties
(23, Deployment Packages J[R168400  Seagate HD, 146G,5A5,3,10K,2.5,5GT2,0U, ...  80.00 % @ rep
#-3f Operating System Deployment J[R168398  Hitachi 10K, SAS, 2.5'FF, 73GB, DU, 10K, SA... 80.00%
&M Software Metering 5IR168402  Seagate NS,10K,5AS3.5",400GE,DU, v.NS25...  80.00 % Description
3 g Reporting ) 5]R168439  Fujitsu ALLOSK, 2.5", 15K, SAS, 73GB, DU, A... 80.00% 7 Items selected.
-] Desired Configuration Management JTR168437  Fujitsu ALIOSE, 2.5", 10K, SAS, 73GB, DU, A... 80.00 %
LA, Queries IR178156  Dell Server BIOS 106, 01.01.03 0,00 %
I Mobie Device Management BIR178450  Dell Server BIOS, Server BIOS 106, 2.2.6 80.00 %
=M Network Access Protection JIR178459  Dell Server BIOS 10G, 2.2.6 80.00 %
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21. Navigate to Site Database > Computer Management > Soft-
ware Updates > Update Repository > Updates > Dell > All
Updates to review what updates require deployment.

f Configuration Manager Console =18(x|

Action View Window Help JSETES)
e > |am| 2@
System Center Configuration Manager BRI ECSSE AR TG Actions

=+ Site Database (CPP - PE2900-5CCM,

-3 Site Management LookFor: [ in [l Columns = Endiiow Clear Allfedise
E Computer Management ‘@ Give Feedback
54 Colections w5 .
4 Conflicting Records
[#-£5 Software Distribution 1 MNew Window from Here
B Software Updates
;[Q Update Repository : i Refresh
3 Search Folders 1 1 2 Heb
1 4 Selected Items -
: i ] Deploy Software Updates
1 1 [#] Download Software Updates
: i [ Update List
=3 1 1 Copy
Ee-(2, Update Lists 1 1 Refresh
[#-{c}, Deployment Templates 1 1
(-2, Deployment Managemen! 1 1 Properties
-0, Deployment Packages 1 1 5 @ Help
(-4 Operating System Deploymer 0 1 1 5
(-4 Software Metering 5TR68041  Dell Server System BIOS, Al1 80.00 % 0 0 4 1 s Important Description *
o} g Reporting ) ©7R68074  DellESM Firmware, A33 80.00 % 0 0 4 1 5 Important 16 Ttems selected.
(1] Desired Configuration Manag || STpaz055  Dell PERC 4/IM, v.1.9.11.0, GO 80.00 % 0 0 4 1 5 Critical
B, Queries SRs3488  Dell ESM Firmware, AD2 80.00 % 0 0 4 1 5 Moderate
E E‘h x:sl ii?(‘i:ﬁ'zf:z;:t IRS0466  LST Logic CERC ATA 100, v.6.62, A3 80.00% 0 0 4 1 5 Moderate
B8 Sy.stem Status o j R47682 Dell PERC 4/IM, v.1.8.6, ADD 80.00 % 0 0 4 1 ) S Moderate
%] [ Security Rights of j RS8591 SILICON IMAGE 516804, v.1.0.0.22, AD1 80.00 % 0 o 4 ik s Moderate
B -i: Tools jR87EES Dell Server System BIOS, A13 80.00 % o 0 4 1 S Important
jRg‘IEDl Intel PRO Fast Ethernet Adapters, v.8.0.17....  80.00 % o o # 1 S Important
JJR100445  Intel PRO Gigabit Adapters, v.8.4.21.0, AQD-... 80.00 % i 0 4 1 S Important
J[R94803  Intel PRO Gigabit Adapters, v.8.4.21.0, ADD-... 80.00 % i i 4 1 5 Important
$]R87336  Dell Server System BIOS, AQS 80.00 % 0 0 4 1 5 Important
B]R87575  Dell Server System BIOS, A12 80.00 % 0 i 4 1 5 Important
]R100373  LSI Logic PERC 4/5C, PERC 4/DC, PERC 4¢/D...  80.00 % 0 0 4 1 5 Important
5]R98040  Adaptec U320 SCSIRAID D or 1, v.2.0.0.363...  80.00 % 0 0 4 1 5 Important
5]Re7577  Dell Server System BIOS, ADS 80.00% 0 0 4 1 5 Important
;j RS2213 SILICON IMAGE 516804, v.1.0.0.12, A0 80.00 % 0 0 4 1 S Moderate
leUD‘HT Intel PRO Fast Ethernet Adapters, v.8.0.17, 80.00 % o 0 # 1 S Important
jR‘?‘IEEH Intel PRO Fast Ethernet Adapters, v.8.0.17. 80.00 % o o 4 1 S Important
jRg‘IGBl Dell Server System BIOS, A14 80.00 % o o 4 i S Important
J[R87059  Dell PERC 4/IM, v.1.9.11.0, AD2 80.00 % i i 4 1 s Critical
J[R115322  Dell Server System BIOS, A6 80.00 % 0 (i 4 1 5 Important
BIR115324  Dell Server System BIOS, AQ6 80.00 % 0 i 4 1 5 Important
J[R117418  Dell ESM Firmware, A37 80.00 % 0 0 4 1 5 Important
$1R143003  Dell Powervaulk 1107 LTO-2-L (Certance), v....  80.00% 0 0 4 1 5 Critical
$TR141501  Dell Powervault 1107 LTO-3, v.6B20, A03 80.00 % 0 0 4 1 5 Important
{leJUQﬁT Dell Powervault 100T DAT72, v.A16E, A10 80.00 % 0 o 4 1 S Important
57R99805  Dell Backplane Firmware, v.1,00, ADL 80.00 % 0 0 4 1 5 Important
!j R126742 Adaptec CERC SATA 25, v.6.0,3643.4, A3 80.00 % 0 o X 1 S Important
#?Rlzsms Adaptec CERC SATA 2s, v.6.0.50.5, AD6 80.00 % 0 0 4 1 5 lmpmtai‘ﬂ
K | :

This completes importing Dell Updates into the SCCM server and
deploying Dell OpenManage Inventory Agent / evaluating Dell Up-
dates. Manage and deploy the rest of the Dell Updates as desired
per the environment.
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SECTION 6

Tips and Best Practices Using SCUP and SCCM (Q&A)

This section will cover common questions or issues that may occur.

Question: Updates fail to publish from SCUP to WSUS.

Publish Wizard

Qg Confirmation

Summary

Progress

Gonfirmation:

Q Errors occurred during publishing on one or more of the approved updates:

Successfully published 253 of 474 items to the update server,
The following 221 update(s) were not published due to an error during publishing to the
update server;

Error 1: Dell BMC Firmware, v.2.03, 407

Error 2: Adaptec 39160 SCSI - Family Manager Set, v.6.4.630.101, A13
Error 3: Adaptec 393204 Leadfree Controller, v.7.0.4.1, AD2

Error 4: Adaptec PERC3/Di, v.2.8.1.7692, 413

Errar 5: Dell Server System BIOS, Al4

Error 6: Intel PRO PCI-E 4 Port Gigabit Base Driver, v.10.0, A01

Error 7. Dell Server System BIOS, A21

Error 8: Dell SAS Si Intearated, v.1.24.04.40, A06

Error 9: Adaptec PERC3/Di, v.2.8.1.7692, 413

Error 10: Dell PowerVault 100T DDS4, v.912L, Al18

Error 11: Dell BMC Firmware, v.1.72, A06

Error 12: Dell CERC 6/i Integrated, v.6.0.2-0002, A03

Error 13: Intel PRO PCI-E Gigabit Family of Adapters (2007), v.10.0, AD2
Error 14: Dell PowerYault RD1000 External, v.2021, AD1

Error 15: Adaptec U320 SCSIRAID O or 1, v.2.0.0.3635, ADD

Error 16: Intel PRO Fast Ethernet Adapters, v.8.0.17.0, ADD-8.2

Error 17: Dell Server BIOS, Server BIOS 10G, 2.2.6

Error 18: Dell PERC 6/i Integrated, v.6.0.2-0002, AD3

Error 19: Dell BMC Firmware, v.1.11, A04

Error 20: Dell PowerVault LTO4-120, v.74H6, ADG

Error 21: Dell Remote Access Controller - DRAC II1, v.3.37, A00

To exit the publish wizard, click close.

< Previous fext > Einish

i

Answer:

Investigate the SCUP log file located at %temp%\UpdatePublisher.log.

Tip: The log file can be difficult to read using notepad, search the web
and download the Microsoft log viewer application called SMS Trace.
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Question: Upon investigating the UpdatePublisher.log SCUP failed
to publish updates to WSUS due to a verification of file signature
failed error .

€2 SMS Trace - [C:\DOCUME~1'ADMINI~1.PDK\LOCALS~1} Temp\UpdatesPublisher.log] =18 x|
&4 Fle Tools Window Help =18 x]
=28 =6 ng
LogText " Component [ Date/Time: [ Thiead I
Publish: - Temporary SDP XML file C:\Documents and Settings\Administrator, PDKALocal Settings\T empMmp354F.tmp created for publishing Updates Publisher 5/3/2008 10:35:284M 6 (0x6) Al
Publish: : Retiieving content for update 'f63ce1 a-1c03-4701-adcd-1fa05413a7ee' from 'ftp://ftp. dell. com/SAS-RAID /DRVR_WIN_R177587.EXE. Updates Publisher 5/3/2008 10:35:284M 6 (0x6)
Publish: : -~ Content will be saved to C:\Documents and Settings\Administiator, PDK\Local Settings\Temp\0fidadih hun\DRVR_WIN_R177587.EXE Updates Publisher 5/3/200810:35:284M 6 (0x6)
Publish: : Downloaded content for update 'if63ce1a-1c03-4701-a4cd-1fa05413a7ee" to local file: C:\Documents and Settings\Administiator. PDK\Local Settings\Temp\Dfidadihhun' Updates Publisher 5/3/200810:35:294M 6 (0x6)
Calling update server API for update 'i83ce1a-1c03-4701-adcd-11a05419a7ee’ Updates Publisher 5/8/2008 10:35:298M 6 (0x6)
Calling update server API for publishing update 'f63ce1a1c03-4701-adcd-1fa05419a7ee" Updates Publisher 5/8/2008 10:35:298M 6 (0x6)
Publish: : Exception oceured during publishing: Verification of fle signature faied for file: \\PE2900-SCCMA\UpdateServicesPackages\Dell SAS 5_iR and 6_iR Adapter, SAS 5_iR an Updates Publisher 5/8/2008 10:35:324M 6 (0x6)
Publish: : -~ Remaving temporary files... Updates Publisher 5/8/2008 10:35:324M 6 (0x6)
Publish: : -~ Completed publishing for update ff3ce1a-1c03-4701-adcd-1fa05419a7ee" Updates Publisher 5/3/2008 10:35:324M 6 (0x6)
Flag For Publish : Performing Flag For publish Action on selected updates. Updates Publisher 5/3/2008 10:46:094M 4 (0x4)
Flag/unflag For Publish : Checking if all updates stil exist. Updates Publisher 5/3/2008 10:46:094M 4 (0x4)
Flag For Publish : Validating Updates for updates publisher compliance Updates Publisher 5/8/2008 10:46:094M 4 (0x4)
Flag for publish : Flag for publish action finished Updates Publisher 5/8/2008 10:46:094M 4 (0x4)
Flag For Publish : Performing Flag For publish Action on selected updates. Updates Publisher 5/8/2008 10:46:144M 4 (0xd)
Flag/unflag For Publish : Checkingif all updates stil exist. Updates Publisher 5/8/200810:46:14AM 4 (0x4)
Flag For Publish : Validating Updates for updates publisher compliance Updates Publisher 5/8/2008 10:46:148M 4 (0x4)
Flag for publish : Flag for publish action finished. Updates Publisher 5/8/2008 10:46:14AM 4 (0x4)
Intialized Publish Wizard. Updates Publisher 5/8/2008 10:46:16AM 4 (0x4)
Publish: : Connecting to update server Updates Publisher 11 (0:8)
Connecting to a local update server with locally detected settings. Updates Publisher 11(0:8)
Publish: : Publishing update: '008162fc-1367-43a7-a717-8b71d63d3179' Updates Publisher 5/3/2008 10:46:17 AM 11 (0xB)
Publish: : -~ SDP XML file for publishing created at C:\Documents and Settings\Administrator PDK\Local Settings\TempAtmp3572.tmp Updates Publisher 5/8/2008 10:46:17 AM 11 (0xB)
Publish: : - Temporary SDP XML file C:\Documents and Settings\Administrator. PDK\Local Setlings\T empmp3572.tmp created for publishing Updates Publisher 5/8/200810:46:17 AM 11 (0xB)
Publish: : Retiieving content for update '008162fc-1367-43a7-a7(7-8671d63d3179' from ftp://ftp.dell. com/esm/PESC1435_ESM_FRMw_WIN_R182830 EXE Updates Publisher 5/8/2008 10:46:17 AM 11 (0xB)
Publish: : - Content will be saved to C:\Documents and Settings\Administrator, PDK\Local Settings\Temp\ridTteqi.qam\PESC1435_ESM_FRMw_WIN_R182830 EXE Updates Publisher 5/8/2008 10:46:17 AM 11 (0xB)
Publish: : Downloaded content for update '008162fc-1367-43a7-a717-8b71d63d9179'to local fle: C:\Documents and Settings\Administrator PDK\Local Settings\T emphridTteqi.qam Updates Publisher 5/8/2008 10:46:224M 11 (0xB)
Calling update server API for update '008162fc-1367-43a7-7(7-8b71d63d9179' Updates Publisher 5/8/2008 10:46:22AM 11 (0xB)
Calling update server API for publishing update '008162fc-1367-43a7-a717-8071d63d9179' Updates Publisher 5/8/2008 10:46:22AM 11 (0xB)
Publish: : Exception occured during publishing: Verification of fle signature failed for file: \\PE2900-SCCMA\UpdateServicesPackages\Dell BMC Firmware, v_2_03, A07_008162ic-13 Updates Publisher 5/8/2008 10:46:28AM 11 (0xB)
i Removing temporary fles... Updates Publisher 5/8/2008 10:46:28AM 11 (0xB)
Completed publishing for update '008162fc-1367-43a7-7(7-8b71d63d9179' Updates Publisher 5/3/2008 10:46:28AM 11 (0xB)
Publish: : Publishing update: *1618fb-ealc-4a50-23(0-61 758167875 Updates Publisher 5/3/2008 10:46:28AM 11 (0xB)
Publish: - -~ SDP XML file for publishing created at C:\Documents and Settings\Administiator. PDK\Local Setlings\T emptmp3579.tmp Updates Publisher 5/3/2008 10:46:28AM 11 (0xB)
Publish: : - Temporary SDP XML file C:\Documents and Settings\Administrator. PDK\Local Setlings\T emptmp3573.tmp created for publishing Updates Publisher 5/8/2008 10:46:28AM 11 (0xB)
Publish: : Retiieving content for update '1361a8fb-ealc-4a50-a310-6175eB87875' from 'ftp://ftp. dell.com/esm/PE 1355_E SM_FRMw/_WIN_R 182889 EXE. Updates Publisher 5/8/2008 10:46:28AM 11 (0xB)
Publish: : - Content will be saved to C:\Documents and Settings\dministiator, PDK\Local Settings\T emphebum52ta hi\PE 1955_ESM_FRMW_WIN_R182883.EXE. Updates Publisher 5/8/200810:46:28AM 11 (0xB)
Publish: : Downloaded content for update '1a61a8fb-ealc-4a50-a9(0-6175e867875' to local file: C:\Documents and Settings\Administiator, PDK\Local Settings\Temp\ebumS2ta hwi Updates Publisher 5/8/2008 10:46:324M 11 (0xB)
Caling update server API for update "1 aB1a8fb-ealc-4a50-3910-61 758167875 Updates Publisher 5/8/2008 10:46:324M 11 (0xB)
Caling update server API for publishing update '1361a8fb-eallc-4a50-a910-6175e8167875" Updates Publisher 5/3/2008 10:46:32AM 11 (0xB)

Removing temporary fils... Updates Publisher

5/8/20081 38 AM

11 (0:8)

Completed publishing for update "1 361a8fb-ealc-4a50-53(0-61 758167875 Updates Publisher 5/8/2008 10:46:38 M 11 (048) EI
Date/Time: 5/8{200810:46:38AM  Component:  Updates Publisher
Thread: 11 (0xB) Source:
Publish: : Exception occured during publishing: Verification of file signature Failed For file: \1PE2300-SCCMIL icesP: Dell BMC Firmware, v_2_03, AD7_la61a8fb-ealc-4a50-a9f0-61 1aa-4c9F-9dct tcab 4|

[Elapsed time is 2826h 40m 385 S62ms (10176038.562 seconds)

Answer:

Ensure the WSUS Publishers Self-signed Certificate was copied to the
Trusted Root Certification Authorities as outlined in the SCUP steps

listed in this document .
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Question: When attempting to deploy the Dell Updates to a SCCM
managed client system the update fails.

Answer: Investigate the managed client systems Windows Update
log file located at %windir%\WindowsUpdate.log for further error de-
tails.
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Question: Upon investigating the WindowsUpdate.log the reason
the update failed was due to a signature failure.

Answer: First ensure that the SCCM managed client system has
the WSUS Publishers Self-signed Certificate in it's Trusted Root Cer-
tification Authorities store as outlined in the SCUP steps listed in this
document. Then follow these steps using the Windows group policy
editor on the managed client system to allow signed content from
intranet Microsoft update service location.

1.

On the SCCM managed client Operating System click the Win-
dows Start button and select the Run option. Type GPE-
DIT.MSC and click OK. Next expand Computer Configuration
> Administrative Templates > Windows Components > Win-
dows Update.

a. If the managed client Operating System is Windows 2000
from the group policy editor right click the Administrative
Templates folder and select Add/Remove Templates.
From the Add/Remove templates menu select Add and
choose wuau.adm and click Open, then click OK from the
Add/Remove templates menu.

Note - This will only be possible on Windows 2000 service
pack 3 or higher.

_lofx]
J Action  View |J<}= -”l‘ I
Tree | Policy | Setting
@ Local Computer Policy Windows Components
=] @ Computer Configuration QSVSth
#)-(_] Software Settings etwaork
C] l;l Wmdows Settlngs [_JPrinters
3 3 Wlndows Components ! 2 _I_l
- System Current Policy Templates:
(£ Network
+(2 Printers | Size | Modified |
=% User Configuration Sfcon 33KB  6/20/2003 3:00 ...
#-(_] Software Settings L] inetres 109KE  6/20/2003 3:00 ...
B+ Windows Settings (=] system 7I6KB  6/20/2003 300 ...
- (] Administrative Templates 8] wuau 49KB  4/16/2007 10:2.

Add... | Remove |

I
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2. Double click “Allow signed content from intranet Microsoft up-
date service location”, select “Enabled” and click OK. Close
the Group Policy editor.

_lox]
'J Action  View H@-b||||§ l

Tree I Policy | Setting |
@ Local Computer Palicy 1-% Configure Automatic Updates Not configured
B @ Computer Configuration @ Specify intranet Microsoft update service location Enabled
(£ Software Settings i-:i Enable client-side targeting Mot configured
(£ Windows Settings ;‘::i Reschedule Automatic Updates scheduled installations Mot configured
=1+ Administrative Templates @ Mo auto-restart for scheduled Automatic Updates installations Mot configured
=] [:] Windows Components }e{i Automatic Updates detection frequency Mot configured
(3 Netteeting 4 Allow Automatic Updates immediate installation Not configured
[ Internet Explorer | & pelay Restart for scheduled installations Mot configured
(1 Task Scheduler ;:f'; Re-prompt for restart with scheduled installations Not configured
_D Windows Installer | &% allow non-administrators to receive update natifications Mot configured
| ‘2 Windows Update @ Enable recommended updates via Automatic Updates Mot configured
3 System @ Enabling Windows Update Power Management to automatically w... Mot configured

(23 Network

(] Printers

= & User Configuration

(Z Software Settings

(3 Windows Settings

(Z Administrative Templates

Enabled

Allow signed content from intranet Microsoft update service location
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Question: How to remove Dell Updates from SCCM

Answer: To remove Dell Updates from SCCM follow these steps to

expire/remove them.

1. In SCCM under the Console Tree expand the Site Database >
Site Management > %Site Name% > Site Settings > Compo-
nent Configuration group and select the properties of the Soft-
ware Update Point Component.

88 Configuration Manager Console 1 =181
9 Fle Action Wiew Window Help [ISETES|
e~ o@m 2@ !
5] System Center Configuration Manager ponent Configuration 5 items found BEUOnS
=] ;?}' Site D.atabase (CPP - PE2900-SCCM, PDK LAB) Component Configuration -
=5 Site Management Lookfor: | | in [All Columns = Find 1o clear
£ PP - POK LAB ‘@ Give Feedback
(8 Site Settings View »
2, Addresses Ttem Name |

{121 Boundaries
{3 Client Agents
153 Client Installation Methods
{i Component Configuration
(L5 Certificates
LB Accounts
155 Discovery Methods
{2 senders
[ Site Maintenance
{23 status Filter Rules
{23 Status Summary
=& Site Systems
(5 1\PE2900-5CCM
=& Computer Management
148 Collections
?5 Conflicting Records
59 Software Distribution
18] Software Updates
-3 Update Repository
£33 Search Folders
=3 Updates
£33 Allupdates
=63 Dell
£33 Allupdates
{3 Bios
Drivers and Applications
-3 Firmware
{3, Microsoft
{3 Update Lists
({23, Deployment Templates
=3 Deployment Management
1-{, Deployment Packages
+] <4 Operating System Deployment
-4 Software Metering

{5 Reporting
1\ Desired Configuration Management
#-|_y Queries
1§ Mobile Device Management
+- 16 Network Access Protection
£ System Status
+-{iy Advertisement Status
{11, Package Status
). [ Site Status
- CPP-PDKLAB
[ Component Status
[ Site System Status
{1} Status Message Queries
-3 Security Rights
B[ Tools

{5 Management Point Component
are Distributi

1 status Reporting
[ System Health Validator Paint Companent.

Refresh

New Window from Here
Refresh
2@ Help
Software Update Point Component
Refresh
Properties
@ Help
Description -
Settings to apply to all software update points

in this ConfigMgr site, like network load
balancing and ports used.

|Opens the properties dialog box for the current selection.

istart| | (& @ 4 |[5 configuration Mana...

4:19PM
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2. The Software Update Point Component Properties screen will ap-
pear, switch to the Sync Schedule tab and check Enable syn-
chronization on a schedule, press OK. This is required for
SCCM to remove the expired updates per the schedule time.

Software Update Point Component Properties x|
General I Sync Settings l Classifications I Products  Sync Schedule I Languages I

Software updates can be synchronized manually or a schedule can be set for
automatic synchronization.

— Synchronization schedule

' Simple schedule

Run every: l 1 _—:_I lHours :_l

" Custom schedule

No custom schedule defined, Customize . I

| oK I Cancel Apply Help
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3. In SCCM navigate to Site Database > Computer Management >
Software Updates > Update Repository > Updates > Dell > All
Updates select the update you wish to remove and click Action >
Properties. From the properties screen choose Expire.

4. Expiring updates will not instantly remove them, a clean up scan
will run 14 days after marking the updates expired and remove
them from SCCM. Updates can not be removed from SCCM if the
updates are included in a deployment package, first delete the
deployment package then expire the updates.

5. Updates may reappear in SCCM if they are not unchecked in the
next SCUP publishing / synchronization.

Note — For advanced steps to remove updates from SCCM search
Microsoft's SCCM forums and Microsoft Technet.

Question: After installing Dell OpenManage Inventory Agent, the
remainder of the updates are still showing the status of unknown.
Answer: Once clients perform their next software updates scan cy-
cle, then the remainder of the updates applicability will be reported to
the SCCM site.

Question: Will many of the steps outlined in this whitepaper be ap-
plicable to System Center Essentials (SCE)?
Answer: Yes, many will be similar but not necessarily exact.

Question: Where can more information be found about Dell Catalog
and Dell OpenManage Inventory Agent?

Answer: ftp:/ftp.dell.com/cmsdk/DellSDPCatalog Readme.doc.
ftp://ftp.dell.com/cmsdk/DSIA Readme.doc.

Question: Where is the Dell SCCM / SCE Catalog located?
Answer: ftp:/ftp.Dell.com/Catalog/DellSDPCatalog.cab.

THIS WHITE PAPER IS FOR INFORMATIONAL PURPOSES ONLY, AND MAY
CONTAIN TYPOGRAPHICAL ERRORS AND TECHNICAL INACCURACIES. THE
CONTENT IS PROVIDED AS IS, WITHOUT EXPRESS OR IMPLIED WARRAN-
TIES OF ANY KIND.

©Copyright 2008 Dell Inc. All rights reserved. Reproduction in any man-
ner whatsoever without the express written permission of Dell Inc. is strictly
forbidden. For more information, contact Dell.

Information in this document is subject to change without notice.
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